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Personal Information — access your personal note, location,
and presence status.

Navigation Buttons — switch between views.

Options Button — access the File menu and other settings.
Add Contact Button — add contacts in or out of your
organization.

Signing In

You can sign into your Lync account directly by opening the

program from your desktop or Start screen.

1. Enter your email address in the Sign in address: box.

2. Enter your password in the Password: box.

3. Optional: To set your status before you sign in, click the arrow
at the Sign in as: box and select a status from the drop-down
menu. You will appear online set as this status.

4. Click the Sign in button. ’

Setting your Presence Status

If you use Outlook, your status is automatically adjusted to reflect
your Outlook Calendar meetings and appointments. You can also
manually set the online availability you wish to display to your
contacts.

Adding a Personal Note

You can add a custom note to instantly share a short message or

additional details with your contacts.

1. In the What’s happening today? conversation box, enter a
short personal note you would like to share with your contacts.

2. Optional: To change .
your personal note, Expl-orlng Lync!
delete your current )
message and press
the Enter key. Type
a new personal note
in the space.

Jess Quinlan
Available ¥
Office ¥

Setting your Location

Along with your presence status and personal note, you can also

display your current location to your contacts.

1. Click Set Your Location.

2. Enter a description of your current location into the box.

3. Click outside the text box to save the location, ~

4, Optional: To change your current location to a previously used
location, click the arrow to select a custom location you have
already used.

Note: If you would rather not display your location information,

you can click the arrow beside your location and uncheck the

Show Others My Location box.

Adding a User Picture

Choose a picture of yourself to display to your contacts. The

maximum size of a user picture is 30 KB.

1. Click the arrow beside the Options & button.

2. Click Tools.

3. Select Options from the drop-down menu.

4. Select My Picture in the left pane of the Lync Options screen.

5. Click Edit or remove picture.

6. Click Browse and select a photo from your files.

7. Click Open.

8. Click Save.

9, Optional: To hide your picture, click the button at Hide my
picture. Click OK to confirm.

Note: To quickly change your user picture, click on your user

photo to open My Picture options.

1. Click the Status arrow to open the
status options. You can select:
e Available: You are online and free to . Busy
talk. i !
. Do Mot Disturb
* Busy: You are busy but can still mn OO
receive conversation alerts. Be Right Back
* Do Not Disturb: Only glerts from your Off Work
Workgroup contacts will appear.
* Be Right Back: You have stepped away Appear Away
and will return soon.

. Ayailable

Reset Stat
« Off Work: You are not at work. i
= Appear Away: Your computer is set to Sign Out
away. o

2. Optional: To return to your previous
status, select Reset Status.

Navigating in Lync@m!
When you open the Lync main window, you can click the view
buttons under your personal information to change your view.
Select the view that displays the features you want to access.
¢ Contacts & view: your default view, which displays your
various contact groups and their current presence status and
network.
s Conversations ™2 view: displays past chats, meetings, and
calls.
e Dial pad ¥ view: displays a dial pad that you can use to
enter in phone numbers for audio calling.
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Contacts & Messaging

Contacts

It's important to populate your list of contacts with the people
you wish to interact with. You can add contacts using the name,
email address, or phone number of another Lync user in your
organization or in a different network. You can also add the email
addresses or user names of Skype users.

Adding a Contact

from your Organization

1. Enter the name, email address, or phone number of a contact
you wish to add in the Find someone space in the main Lync
window.

2. When a desired contact appears, right-click on the name of the
user.

3. Select Add to Contact List from the drop-down menu.

4. Select a group for your contact to belong to. The contact will
appear in the desired list.

Adding a Contact

from Quiside your Organization
If you know the information for the contact outside your

organization, you can directly add that contact to your contact list.

1. Click the Add a Contact & button.

2. Select Add a Contact Not in My Organization.

8. Choose the type of contact by selecting Lync, Skype, or Other.

4. Enter the contact information for the new contact in the IM
Address: box.

5. Optional: To set a privacy level for your new contact, click the
arrow in the Set Privacy relationship: box and select a privacy
relationship.

6. Optional: To add your contact to a group, click the arrow in
the Add to contact group: box and select a group.

7. Click OK.

Note: To delete a contact, right-click on the contact and select

Remove from Contacts List. Click Yes to confirm.

Using Contact Groups

You can organize your contacts into groups according to how
often you speak with them or by who you work with. The two
default groups are Favorites, for your most commonly used
contacts, and Other Contacts. You can also create your own
custom groups. Add users to groups when you add them as
contacts, or organize your existing contacts by right-clicking the
contact and selecting Move Contact To from the drop-down menu.

Creating a New Contact Group

1. Click the Add a Contact &= button.

2. Select Create a New Group.

3. The new group will appear in your groups view. Click in the
blue-highlighted New Group space to enter in a name for your
group. -

4. Click and drag contacts to place d m
them into the new group.

5. Optional: To delete a group, right-
click on the group and select Delete Group.

6. Optional: To expand a contact group and view contacts, click
the Arrow I button.

Messaging
Using the Quick Lync Bar (new!

The Quick Lync bar gives you instant access

to common tools for interacting with

contacts.

1. To open the Quick Lync bar, hover your pointer over the user
picture of the contact with whom you wish to interact.

-~

\_wx"'

2. Click one of & I
the Quick Lyne . @ @ '@ cae
buttons to
interact with
the user, including:
e Send an IM &

e Call Contact (©
e Start Video Call ®

* See Contact Card (=
e More -

Sending an Instant Message

1. Double-click on the contact you wish to instant message in
your Contacts List or click the IM ® button on the Quick
Lync menu.

2. Type your message into the text box provided and press the
Enter key to send.

3. Optional: To change the font type, size, or color of your
message text, click the Font | ~ | button. Select a text color
from the palette or click the arrows on the Font or Font Size
boxes.

4. Optional: To insert an emoticon, click the Smiley | | button.
Select the desired expression from the palette.

5. Optional: To set the importance level of the message to high,
click the Set high importance for this message | ! | button.

6. Optional: To invite a contact to an ongoing conversation,
hover over the Participants (=) button. Select a recent contact
or click Invite More People to choose from your contacts.

7. Click the Close * button when you have finished the
conversation.

Using Tabbed Conversations @EW!
Tabbed conversations help you manage chats, calls, and other
conversations going on simultaneously in one screen. When you
open more than one conversation, the messages will automatically
appear as tabs in the screen’s sidebar.

e To switch between F prror— = E R
conversations, click |[we - lotnpeters
the name of the Sl m—
contact in the sidebar) ™=
To close a
conversation, hover
your mouse pointer
over the name of ]
the contact until ]
the Close ¥ button |
appears.
To expand a
conversation into its
own separate window, click the Pop-out # button on the
upper right corner of the screen.

Da yau yiant 1o meet after lunch to go cver the next phase? =]

John Peters 1242 PM
| can do that

| have a meeting with Susan at 3, but that shouldn't M
take very leng. |
Haw about 4:157

| Last message recend on 1172072013 at 1243 FM.

00®e®
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Meetings

With Lyne, you can schedule and participate in online meetings
with other contacts in your organization. To use Lync meetings
optimally, yvou will need to use Microsoft Outlook. To use the
full features of Lync meetings, you will also need a webcam and
microphone.

Scheduling a Meeting in Lync

1. In your Lync window’s Contact view, right-click the contact
with which you wish to schedule a meeting.

2. Click Schedule a Meeting.

3. When the S ! i
; John Peters - Available - Video Capable
Outlook window - D E— '_)f__
opens, e_nter Send an [M
the details of P D Gtadis| Gl i
the meeting 4 Coworkers (0/3) o
such as Subject, 2 ‘ il Starta Video Call
Location, Start H mrayti B Send an Email Message
time, End time, [ schedule 2 Meeting

and any agenda -
information in the body space.

&, Optional: To set a reminder for the meeting, click the arrow on
the Reminder: box and check a time to be reminded.

5. Optional: On the Meeting tab, click the Scheduling = button
in the Show group. Coordinate your meeting with your
contacts’ schedules to avoid conflicts.

6. Click the Send = button.

Scheduling a Meeting

with your Outlook Calendar

1. Open your Microsoft Outlook program.

2. Click on the Calendar.

3. Click the New Lync Meeting ® button in the Lync Meeting
group.

4. Enter the email addresses of the contacts you wish to invite.

5. Enter a Subject, Location, Start time, End time, and any
agenda information in the body space.

6. Optional: On the Meeting tab, click the Scheduling = button
in the Show group. Coordinate your meeting with your
contacts’ schedules to avoid scheduling and location conflicts.

7. Click Send.

N:@ Scheduling a Meeting
with Lync Web Scheduler

If you don’t use Qutlook, you can still schedule meetings by using

the Lync Web Scheduler with your Internet connection. Contacts

you invite to the meeting will receive a link to the Lync Web App

Meetmg Client.

. Open Internet Explorer or another web browser.

2. Enter https:/sched.lync.com into the web address bar.

3. If prompted, login to the Office 365 portal with your user
name and password.

4. Enter information in the General, Meeting Time, Access and
Presenters, Participants and Audio sections to set the details
of your meeting. Required sections are denoted hy a red
asterisk.

5. Click Save.

6. Click OK.

Note: To view your meetings, click the MY MEETINGS link. Your

scheduled meetings will appear in alphabetical order according to

subject,

3

Meetings

Joining a Scheduled Meeting (
1. Open the meeting request or reminder.
2. Click Join Lync Meeting. \
3. Choose one of the following audio
connection options from the Join

Meeting Audio window. %
» Use Lync: the
recommended option for
Lync meetings, for use
with available wehcam,
mic and speakers or _ -
headset. ) Don't join audio
e Call me at: enter a phone
number to dial-in to a
conference or select a set
number from your Phones
options.
* Don’t join audio: use
when calling into a meeting from a phone.
4. Click OK.
Note: If you don’t have a webcam on your computer, you'll still be
able to see the videos from other users in the meeting.

Join Meeting Audio

8 Use Lyne (full audia and video experience)

_ Callme at:

[”] Don't show this again

FYl: Find these settings in Options under Phones.

oK | cancel

Participating in a Meeting
1. Once you have joined a meeting, you can do one of the
following options:

o To view information on other attendees, view the participant
list. The icons beside the names will indicate chat, audio, and
video capability of each attendee.

e To chat in a meeting, enter your instant message into
the message space at the bottom of the screen. Enter any
emoticons or adjust the font as desired.

e To share a video of yourself in a meefing, click the Video &)
button. Click Start my video.

e To end sharing your video, click Stop my video.

o To exit a meefing, click the More -~ button, Select End
Meeting from the pop-up menu. Click OK. (ff you are not
the presenter, simply close the conversation window. The
meeting will go on without you.)

Recording a Meeting

Recording a meeting in Lync is a good way to keep track of ideas

or help with note-taking. Only presenters have the authority to

record a meeting.

1. In the meeting window, click the More --- button.

2. Select Start Recording.

3. Optional: To pause, stop, or resume the recording, use the
controls at the bottom of the meeting.

4. When you are finished recording, click Stop Recording. Lync
Recording Manager will display an alert when the recording is
ready to be shared.

5. Optional: To share the recording, click the alert or click the
Settings 1 button and select Tools. Open the Recording
Manager. Click Browse and locate the MP4 file of the
recording. From here you can copy or share the file through
email or instant message.

6. Optional: To rename the recording, click the alert or click
the Settings % button and select Tools. Open the Recording
Manager. Click Rename.

7. Optional: To delete the recording, click the alert or click the
Settings ¥ button and select Tools. Open the Recording
Manager. Click Delete.

Note: Recordings are automatically saved in your computer’s

Video/Lync Recording file.
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Meetings Continued

Adding Users to a Meeting

Once in a meeting, a presenter can add additional users as needed.
1. In the meeting window, click the Invite More People button.
2. Select additional contacts from the list or enter the name of a

contact in the search bar. L

3. Click OK.
~ 2,
Presenting Content y
through Lync Meetings 4.

One of the most powerful features in Lync is the ability to directly

present content to your contacts. You train new employees in shared 5.

programs or present ideas directly with a PowerPoint presentation. 6.

Vou can choose to share your entire desktop display or just a specific

program you're working in. You can also share during individual

conversations as well as in
meetings.

1. In a meeting, hover your
mouse cursor over the
Present (=) button.

2. From here, you can share

®

PRESENT | ONENOTE = ATTACHMENTS

Mo one is presenting.

s B B O

one of the following: Aftoriion: SOy Jentan g
¢ Desktop: displays your o - -
entire desktop screen. Ej Ef
PowerPoint Whiteboard Poll Q&A

» Program: displays your
work in a selected
program.

= Q&A: displays other — =
attendees’ questions for you or a presenter to answer.

= PowerPoint: displays a complete PowerPoint file.

= Whiteboard: displays a writing slate.

e Poll: displays a poll that your contact can participate in.

Optional: To give your participants control over the screen, click 2.

the Give Control on the sharing toolbar at the top of the screen.

Take back control of the screen by clicking Take Back Control. 4.

4. Click Stop Presenting to end the sharing session and return to

your private screen.

Note: When you are presenting in Lync, your status will

automatically change to Presenting. No instant messages or calls

will come through while you are sharing. You should also make

sure you close any sensitive or private information that may be 1

open on your desktop before you begin sharing.

Manage Presentable Content

1.

2.
Taking Notes in a Meeting with OneNote 3.
You can share and coedit notes with participants of a meeting using
OneNote. The note you share must be in a location that other users

can access, such as SharePoint or SkyDrive.

1. In a meeting, hover your mouse cursor over the Present &
button.

2. Click the OneNote tab.

3. Click the Shared Notes ™ button.

4. Select a page or section to share and click OK. Participants will
receive a notification about the note in the meeting.

5. Optional: To see who has access to your notebook, click Check
who has access to the selected notebook.

6. Optional: To create a new notebook to share in, click New

Notebook. Enter a name for your notebook in the Notebook
Name: space. Opened OneNote notes that you have shared will
appear in the OneNote tab in your meeting window.

Sharing an Attachment

You can share folders or files with your
contacts by attaching them through an .
instant message or in a meeting.

In a meeting or conversation window,
hover your mouse cursor over the
Present & button.

Click the Attachments tab.

Click the Add Attachment | button.

Select the file you wish to share in your computer’s folders or

SkyDrive.

Click Open.

The attachment file will appear in the Attachments window.

From here, you can do one of the following option:

s To share the attachment in the conversation or meeting
window, click Open.

s To set who can download the attachment in a meeling,
click the arrow beside the Permissions button. Select
Organizer if you want to be the only one with access to the
file. Select Presenters if you would like to give access to
other presenters. Choose Everyone if you would like to give
everyone access to the file.

® To rename or save the file in a new location, click the arrow
beside the More button. Select Rename or Save as.

¢ To remove the file, click the Remove button.

Downloading Meeting Content
You can save content such as polls or questions and answers
presented in a meeting for future reference.

In a meeting conversation window, hover your mouse cursor
over the Present = button.
Click Manage Presentable Content.

3. Click More.

Select Save As or Save with Annotations to download the
content to your computer’s folders or SkyDrive.

Setting Presenter Meeting Options

If you are a presenter in a meeting, you can control certain aspects
of the meeting to optimize your attendees’ experience.

. In the meeting conversation window, hover your mouse cursor

over the Participants &= button.

Click on the Actions tab. l PARTICIPANTS ACTIONS i

From here, you can do one of
[ ]

the following options:

o To hide the names of participants, click the Hide Names &
button.

o To mute the audience, click the Mute Audience ! button.

e To turn off instant messages for participants, click the No
Meeting IM ® button.

* To send an email invite to additional participants, click the
Invite by Email = button.

» To set all participants as aftendees, click the Everyone an
Attendee % button.

s To limif atfendee videos, click the No Attendee Video &
button.

s To dock or undock the Participants section in the meeting
conversation window, click the Dock & button.

Note: You can also add participanis from the Action tab by

clicking the Invite More People buttfon and adding the contacts
you wish fo include.
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Calling

Calling

You can use your Lync program to make and receive calls just as
you would on a traditional phone using your computer’s audio
devices such as speakers and headset or microphone. To set up
your audio device, click the Select Primary Settings button in the
bottom-left corner of your screen. Click Audio Device Settings.
Select your desired audio device and adjust the settings as
necessary for your calls.

Placing a Call
1.

Enter the name of the contact you wish to call in the search

©-®

bar.

2. Hover your mouse pointer over the user
picture of the contact you wish to call to
open the Quick Lync bar.

3. Click the Call (©) button or click the arrow
to select Lyne Call or a specific listed phone number. The call
will open in a new Lync window.

4, Optional: To mute a call, hover your mouse cursor over the
Call (© button to open call options. Click the Mute button at
the bottom of the call window.

5. Optional: To put a call on hold, hover your mouse cursor over
the Call (© button to open call options. Click the Hold Call
button at the bottom of the call window.

6. Optional: To transfer a call, click the Transfer Call tab. Select a
number to transfer the call.

Note: You can also place an audio call by clicking the Dial pad “

button on the main Lync window. Enter the phone number and

click Call.

2 LyncCal

Answering an Incoming Call

1. When a contact calls you, a new Lync call alert will appear on
your screen.

2. From here, you can do one of the following:

e To accept a call, click in the photo area of the call alert
screen.

o To reply by instant message, click the arrow beside Options.
Select Reply by IM.

o To accept a call but not share your own video, click the
arrow beside Options. Select Answer with Audio Only.

e To reject a call and set your status to reject future calls,
click the arrow beside Options. Select Set to Do Not
Disturb.

» To reject a call, click Ignore.

Starting a Conference Call

1. In the Contacts view of your Lync main window, click and hold
the Ctrl key to select contacts to include in your conference
call.

2. Right-click on any part of the blue area in the selected contact
space.

3. Select Start a Conference Call from the drop-down menu.

4. Click Lync Call. Your contacts will receive a notification. They
can accept or decline the call.

5. Opfional: To add more contacts once you're in the conference
call, click Invite More People to select an additional
participant. The call will be automatically added to the
on-going conversation.

Using Video Calling
To use video calling, you will need to
have a working webcam available on your
computer.

1. Enter the name of the contact you wish
to call in the search bar.

2. Hover your mouse pointer over the user picture of the contact
vou wish to call to open the Quick Lync bar.

3. Click the Start a Video Call & hutton or click the arrow to
select Lyne Call or a specific number. The call will open in a
new Lync window.

4. Optional: To change the layout of the video call, click Pick a
Layout and select one of the layout views:

e Gallery View: see all participant videos.

e Presenter View: see presenter’s video prominently as well as
any shared content.

» Content View: see only shared content instead of video
streams of participants or presenters.

» Compact View: see a compacted version of all videos in a tile
format.

5. Hover your mouse cursor over the Start a Video Call @
button to open the video conversation options. From here, you
can do one of the following:

e To not share your own video stream in the call, click Stop
My Video. Your contact’s video stream will still appear.

s To end all video streaming and return the call fo just audio,
click End Video.

Adding a Phone

1. Click the arrow beside the Options <+ button.

2. Select Tools from the drop-down menu.

3. Select Options.

4. In the left pane, click Phones.

5. In the My phone numbers section, click Work Phone, Mobile
Phone, Home Phone, or Other Phone to add a phone number.

6. When the Edit Phone Number window opens, enter the phone
number in the Phone number: space.

7. Optional: To include the number on your contact card for your
contacts to view, check the box beside Include in my contact
card.

8. When you are finished, click OK.

Adjusting Audio and Visual Settings

To use audio and visual elements of Lync, you will need to make

sure your devices are configured correctly.

1. Click the arrow beside the Options <+ button.

2. Select Tools from the drop-down menu.

3. Click Audio or Visual Device Settings.

4. Test your settings to verify that your devices are working
properly.

To order call toll-free 1-800-296-5750.
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Extras, Privacy, Shortcuts & Getting Help

Extras

newl) Organizing your Contacts

By default, Lync will load in your Contacts view. You can further
navigate your Lync features by clicking on one of the specific views
available to display your contact’s recent activity.

GROUPS | STATUS | RELATIONSHIPS NEWh

s Groups: View your contacts by group.

e Status: View your contacts by their availability status.

¢ Relationships: View your contacts by vour relationship access
to them, such as family or workgroup.

e New: View your contacts list by who has added you most
recently.

Adjustmg your Dlsplay Options
Click the Add a Contact & button.

2. Click Display options.

3. Click the buttons to toggle the display and order options to
suit your preferences.

4. Optional: Check options in the Show this information: section
to show or hide details.

5. Click OK.

Displaying the Menu Bar

For easier access to Lync’s tools and options, you can choose to

display the Menu bar in your Lync window.

1. Click the arrow beside the Options <+ button.

2. Click Show Menu Bar from the drop-down menu.

3. Optional: To remove the menu bar, uncheck the mark beside
Show Menu Bar.

Privacy

Signing Out

1. Click the arrow beside the Options ©+ button.

2. Click File.

3. Select Sign Out from the drop-down menu.

4. Optional: To clear your sign-in information on a computer
used by multiple users, click the Delete my sign-in info link.

Note: To sign into a different account, select Change Sign In

Account.

Setting a Privacy Relationship
You may wish to organize your contacts by who can see what
content. For instance, you might not want your coworkers to be
able to see your home phone number, but you might want to keep
this information visible to family members.
1. Inyour Contacts view, right-click the name of the contact to
which you wish to set a privacy relationship.
2. Click Change Privacy Relationship and select a privacy setting.
e External Contacts: the default privacy setting, displays only
your title, company, picture and email address.
¢ Friends and Family: shares all content except meeting
details.
e Workgroup: shares all content except for Home and Other
phone numbers.
¢ Colleagues: shares your note and location, but not Home and
Other phone numbers or your meeting details,
* Blocked Contacts: displays only name and email address.
Contacts set to Blocked cannot use Lync to contact you.

Shortcuts

Conversation Shortcuts

Help ...
View in Full Screen SRR 1t

Exit Full Screen... RS .11 1 .

Close Conversatlon Wmdow v Alt + F4

Mute .. st WinAows Key + F4
Camera On/Off e Windows Key + F5
ACCept INVILE ..ovoveveceeceesissssssssssssssssssnnnene. Windows Key + A
Decline INVIte ..o, Windows Key+ Esc
Save Conversation ... G+ S

| O75T0 - 671 [ . | 4 8

Put a Call on Hold ....ccovcccvcrvvccoenniiieieoe. Ctrl + Shift + H
SElestBll o G oL

Cub: Ctrl + X

2T TSN 01 » ¢ S S 14

10T O 0 i d U 2 O

Undo .. Ctrl + Z

|20 (s N 14 4 I S 4

Navigating Shortcuts

Moveto Contaet Tist senusmsnnesuinnnsssnss
Move to Conversation List ...
Move to Phone tab ...
Start Meet Now ........
Open File Menu .......
Open Tools Menu

Ctrl + 1

FoT0A o] s Y 15 SO 0: 4 o I 1)

EXpand GrOUD ..o SpACEDAY

Move Group Up .. Alt + Up Arrow
Move Group DOWN e Al + Down Arrow
Delete GroUD .o €12TE

Getting Help

Accessing Lync Help
1. Click the arrow beside the Options <+ button.
2. Select Help from the drop-down menu.
3. Click Lync Help.
4. From here you can do one of the following:
¢ To view the Lync Help home page, containing links to
common help topics, click the Home @ button.
e To print a Help article, click the Print = button. Adjust
any printing settings in the Print window and click Print.
¢ To navigate between articles, click the Back © or Forward
@ buttons.
¢ To increase the font size in Help articles, click the Use
Large Text A button.
5. When you are finished using Lync Help, click the Close *
button to exit the Help window.
Note: If you are having trouble with certain Lync funclions,
you may need to contact your system administrator. Your
version of Office 365 may not have access to all available Lync
features, or these features may not be enabled on your account.
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